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Preface

Revised: October 9th, 2009,

The following manual relates to the operation of the Cisco Unified Business/Department Attendant
Console (CUBAC/CUDAC) software product ranges.

Cisco Unified Business/Department Attendant Console is an efficient application specially designed for
handling calls and messages. This application enables you to answer calls from predefined set of queues
and transfer them to desired extensions.

The application enables you to perform comprehensive tasks like Call Conference, Call Transfer, Call
Parking and Call Retrievals. The user-friendly design of the application gives speed and flexibility and
facilitates you to manipulate calls with simple mouse clicks or keystrokes.

The screen-based operator console that has been developed to work exclusively on Cisco Unified
Communications Manager. The traditional functions of a telephone switchboard have been re-created as
a Windows application. It is visually more appealing, easier to operate and more user friendly. Figure 1
displays the default layout of the Cisco Unified Business/Department Attendant Console.

Figure 1 Displays the Default Layout of the Cisco Unified Business/Department Attendant
Console
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Purpose of this Guide

The purpose of this user guide is to:
e Provide information on configuring and initializing the Attendant Console.

e Instruct you to perform actions related to answering, holding, receiving, conferencing, and
transferring calls. It also discusses procedures for toggling, making and retrieving calls.

Who Should Read this Guide

The document is intended for:
e Those involved in the training of Cisco Unified Business/Department Attendant Console

e Users of Cisco Unified Business/Department Attendant Console

Organization

This guide includes the following chapters:

Chapter Title Description

1 Getting Started This section explains the interface of the
Attendant Console. The basic functions of
starting up and logging into the application are
explained here.

2 Customizing Attendant Console This section guides you to customize the
application. Different configurations and
preferences are also explained in this section.

3 Using Attendant Console This section covers topics on answering and
clearing calls, taking notes, holding, transferring
and making calls.

Conventions

This document uses the following conventions:

Convention Indication

bold font Commands and keywords and user-entered text appear in bold font.

italic font Document titles, new or emphasized terms, and arguments for which you supply
values are in italic font.

[ 1] Elements in square brackets are optional.

{xlylz} Required alternative keywords are grouped in braces and separated by

vertical bars.

[xlylz] Optional alternative keywords are grouped in brackets and separated by
vertical bars.

Cisco Unified Business/Department Attendant Console User Guide
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string A nonquoted set of characters. Do not use quotation marks around the string or
the string will include the quotation marks.
courier font Terminal sessions and information the system displays appear in courier font.
< > Nonprinting characters such as passwords are in angle brackets.
[ ] Default responses to system prompts are in square brackets.
I, # An exclamation point (!) or a pound sign (#) at the beginning of a line of code
indicates a comment line.

Means reader take note.

Means the following information will help you solve a problem.

Caution

Means reader be careful. In this situation, you might perform an action that could result in equipment
damage or loss of data.

Timesaver

A

Warning

Means the described action saves time. You can save time by performing the action described in
the paragraph.

Means reader be warned. In this situation, you might perform an action that could result in
bodily injury.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS Version 2.0.

[ oL-20131-01
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= CHAPTER 1

Getting Started

Revised: October 9th, 2009

Cisco Unified Business/Department Attendant Console must have the relevant telephony software and
hardware installed and configured. For details see, Cisco Unified Business/Department Attendant
Admin Web Admin /Installation Guide. Contact your system administrator to configure your system.

Accessibility for Users with Disabilities

Cisco Unified Business/Department Attendant Console provides accessibility features that make it
easier for blind and visually impaired users to use the application.

Attendant Console provides the ability to customize the appearance of the application making it simpler
for users with low vision to adjust the look of the console. This allows users to work in the manner that
they find most comfortable. To access the console settings choose Options>Preferences from the menu
bar.

The software can be used with a mouse as well as keyboard navigations. The keyboard navigations have
been listed in the following section. For the user’s convenience graphical buttons are also available. Each
icon displays a tool tip when the mouse is hovered on it, clearly defining the function of the graphic
button. A list of icons along with their descriptions has also been provided in the following sections.

Attendants also have an option to use Cisco Unified Business/Department Attendant Console with a
screen reader plug in called JAWS. The screen reader provides the attendant with information on the
status of the attendant console as well as with information about the text in the attendant console
windows.

Cisco Unified Business/Department Attendant Console also comes with context-sensitive help. For
every page, users can access help specific to a window or a field by simply clicking F1.

For more information on Cisco Accessibility Program please contact through the following link,

http://www.cisco.com/web/about/responsibility/accessibility/contact.html

Using the Keyboard

Most of the operations can be performed through mouse clicks; however, you can also use the keyboard
to perform call control operations. Table 1-1 Shows the function keys that can be used to operate
Attendant Console.

Cisco Unified Business/Department Attendant Console User Guide
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Key Descriptions

Table 1-1 Shows the Functions that can be Performed Using the Keyboard
Key Name Description

F1 Help

F2 Alternative Numbers, BLF and Presence Status

F3 Internal Directory Field

Fa External Directory Field

F5 Call Progress Field

F6 Speed Dials Field

F7 Active Calls Field

F8 Queued Calls Field

F9 (for Cisco Unified  |Queues Field
Business Attendant
Console Only)

F10 Go Unavailable

F12 Contact Details

Backspace Number Correction. Cancels the misdialed numbers

Insert Camp on. Used to stack a call against a busy extension.

Delete Re-establish. Retry a call.

Page Down Hold/Retrieve. One key depression places the call on Hold. Pressing the key
again retrieves the held call. Any call that returns to the Call Progress Field; for
example, no reply or a parked call is retrieved in the same way

Enter Connect/Clear. Either connects the call or clears the call down depending on the
operating transaction in process

Plus Answer Next/Toggle. Answers the next highest priority call or when offering a
call will toggle between calling and called parties

Minus Cancel Consult. Having offered a call, if the called party refuses, the key will
drop the called party and the calling party is in circuit

Home Call Park. Press to park a call on a park extension number

End Conference. Used to start the conference procedure and then add parties

Context Key

Used to bring up the associated menu in the highlighted Field Header, use TJ' to
required item and Enter key to select

Space Bar

Used to delete the number whilst in the process of dialing out

Tab Key

Used to jump across Directory search Fields

Cisco Unified Business/Department Attendant Console User Guide
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Loggingin

Additional Functions

You can perform additional functions using the CONTROL (Ctrl) key. These are explained in Table 1-2.

Table 1-2 Shows Combination Keys Used to Perform Certain Operations

Key Combination Description

CtrI*F2 Used to display the Lateral Search (Cross
tab)within the directories. This requires enabling in
Preferences

Ctrl*E5 Used to Display My Camped on Calls

Ctrl*M Used for sending an email to an extension user not
responding to a call

CtrlI"E (fOf Cisco Unified Business Attendant Used to force the queues into emergency mode

Console Only)

CtrIrQ Used to Mute a call when certain actions are taken.
This is set up in preferences and the actions include
Performing a Search, Pressing numeric keys to dial
numbers or Changing or Selecting Directory
screens.

CtrI"R Used to reclaim a call

Logging In

You must log in to the application with your Login Name, Password and Extension number. Each user
has a unique identity to log in to Attendant Console. Logging on to Attendant Console also logs you on
to Cisco Unified Attendant Server. After logging on successfully you can process both internal and
external calls.

To login to the attendant Console, perform the following steps:

Procedure

Step 1 Choose File > Login, this will open the Login window. Figure 1-1 shows the Login window.

Cisco Unified Business/Department Attendant Console User Guide
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M Logging In

Figure 1-1 Displays the Window used to Log into the Application

Login 2| x|

— Operator Detailz

Login M arme: IDF'E RATOR1

Fazsword: I“““

— Device Detailz

E=tension: |'| ana

Type: I Handset j

LCancel | Help |

Step2  Type Login Name and Password.

Step3  Enter Extension.

Stepd  Choose a device Type, that is, Headset or Handset.
Step5  Click Login.

Table 1-3 explains the fields displayed in the Login window.
Table 1-3 Explains the Fields Displayed in the Login Window

Field Example Description

Operator Details

Login Name OPERATORI1 You must provide a login name here in order
to log into the application.

Password wkE The password is required for secure login.

Device Details

Extension 1000 Enter the extension number you are using to
handle calls.

Type Handset You can select the type of device you wish to
use. You have a choice between headset or
handset.

The Extension number that is entered during login must be the Primary Number for a device. It is
possible that the same extension number might be configured as a primary number for another device on
a different partition. In order to differentiate between the two devices configured on the same extension
number, the MAC address can be used to identify each device. A MAC address is a unique identifier for
each device.

During login, if multiple instances exist in Cisco Unified Communciations Manager for the directory
number you entered, a Duplicate Device window will be displayed. You can select a MAC address and
view the relevant details for the directory number and select the correct device as shown Figure 1-2.

Cisco Unified Business/Department Attendant Console User Guide
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Note

Go Unavailable (F10)

Figure 1-2 Displays the Duplicate Device Window with Information for the Selected Device

Duplicate Device x|

There iz more than one device configured with your login extenzion.
Pleaze zelect vour local device:

MAL Address: SEPOO141C480D00Y
Directory Mumber; |5351

D ezcription: I.ﬁ.uh:- 5351

R oute Partition: IF.-“-‘-.E.fi‘-.cu:ess

Calling Search Space: IF.-“-‘-.E.fi‘-.cu:ess

ok Cancel

When you select a MAC address, the following information for the selected MAC Address is displayed
as configured in Cisco Unified Communications Manager. This information is described in Table 1-4.

Table 1-4 Describes the fields in the Duplicate Device window

Field

Example Description

MAC Address

SEP00141C48DDD9 This field specifies the MAC Address. This
is the unique identifier for a device. If the
directory number for a device has multiple
instances in Cisco Unified Communications
Manager, the MAC Address is used to
identify the relevant device.

Directory Number 5351 The number used by the operator to log in.

Description Auto5351 This field provides the description for the
device.

Route Partition FACAccess The route partition the extension

is configured on.

Calling Search Space

FACAccess The calling search space the extension is
configured on.

Once the extension is selected, the application will initialize using the selected number. The selected
extension will be used for subsequent sessions from the same PC.

Please note that Shared Lines are NOT supported as Operator phones for technical reasons.

Go Unavailable (F10)

You can take a break by going unavailable for a specific time. The calls will still appear on the console
but you will not be able to answer them. The short cut key for going Unavailable is F10. Figure 1-3
displays the Go Unavailable window that appears when F10 is pressed.

[ oL-20131-01
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Interface

Figure 1-3 Displays the Go Unavailable Window
Go Unavailable TN x|
) ] You are about to go unavailable and will not be able to receive calls unkil you make vourself available.
.\_‘

Are vou sure you want bo continue?

Yes I Mo | Cancel

To become available, click Go Available (F10).

The main interface of Attendant Console consists of the following areas:

Menu Bar

Tool Bar

Queues (F9) (for Cisco Unified Business Attendant Console Only)
All Queues (F8)

Active Calls Area (F7)

Internal Directory (F3) and External Directory (F4)

Call Progress Area (F5)

Call Parking Devices Field

Speed Dials Area (F6)

Figure 1-4 displays Cisco Unified Business/Department Attendant Console interface with a key to
identify the areas of functionality.

© o NSO E DN =

Figure 1-4 Cisco Unified Business/Department Attendant Console Interface
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O
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Menu Bar

Tool Bar

Interface

Table 1-5 describes the options that are available to select from the Menu Bar.

Table 1-5 Lists the Menu Items Along with the Descriptions

Control Name Description

File

Login This option is used to login.

Log out This option logs you out from Attendant Console.
Exit This option is used to close the application.

View

Tool Bar This option activates/deactivates Call Control

tool bar.

Queues (for Cisco Unified Business Attendant
Console Only)

This option allows you to either View All Queues
or View Individual Queues.

Speed Dial

This option activates/deactivates Speed Dial field.

Display Salutation

This option enables/disables the Salutation
Window.

Display My Camped on Calls

This option enables/disables the display of
camped on calls. The shortcut for this function is
(CTRLAFS).

Options

Preference

This option opens the preferences window to
customize Attendant Console.

Emergency (for Cisco Unified Business Attendant
Console Only)

The option allows you to send all the queues in
Emergency Mode. All calls will be forwarded to a
preconfigured destination.

Filter Searching

You can select to switch on phonetic searching
from this menu.

Help

Contents It opens on-screen help.

Keyword Search Allows you to use keywords to search the help
file.

Graphics Displays a graphic panel that displays all of the

graphic icons used within the Attendent Console.

About Attendant Console

It displays the version and copyright information.

The Call Control toolbar is located between the Queued Calls and Active Calls areas. It shows icons for
all the call control operations available at any given time. Figure 1-5 shows an example of the Call
Control toolbar with a selection of items available and some unavailable.

[ oL-20131-01
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W Interface

Figure 1-5 Displays the Call Control Toolbar

e OSSN Y
° w5 E

Table 1-6 displays the options available in the Call Control toolbar.

Table 1-6 Displays Call Control toolbar options

Control Name Icon Description

Answer Call Click to answer a ringing call (not a queued call).
Mute Call ﬁ Click to Mute a Call

Clear Call Click to clear an active call.

Transfer Call 24 Click to transfer the answered call to another

extension.

Retrieve Call Click to retrieve a held call.

Toggle Call

E iy

Use this option to switch between Active and Held

calls.
Re-establish Click to redo an action previously performed on a
call.
Hold with Notes Click to attach information notes to the current call
- before placing the call on hold.
A
Note  The notes are for your use,
and do not get sent on with
the call.
Hold % Click to place a specific call directly on hold.
Contact Properties =t Click to view contact details of the caller.
Start Conference é Click to consult and start conference with another
user.
Conference Click to bring the parties together inconference.
Camp on it Click to transfer a call to a busy extension.
B
Park Call Click to place the call on a call parking device.

Right clicking on a call in the Active Calls area and choosing an option from the context menu can also
perform the above-mentioned operations. You can also access these options using your keyboard (Please
refer to Chapter 1, “Using the Keyboard”section).

Cisco Unified Business/Department Attendant Console User Guide
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Queues (F9) (for Cisco Unified Business Attendant Console Only)

The Queues field of the application displays the queues that are available to the logged in operator. Each
icon represents a different queue. When an incoming call is delivered to the queue, a numeric indicator
appears indicating the number of calls waiting to be answered. A ringing tone is heard by the caller until

the call is answered.

Table 1-7 decribes the icons that are displayed in the Queue (F9) area of the screen.

Table 1-7 Describe Icons Appearing in the Queues Area

Icons

Types of Queues

This is for the Console Queues that are active and
ready to receive calls.

This icon represents the queues that are currently
in night service.

This is for the Queues that are in Emergency
mode.

Table 1-8 describes the functions that can be performed on the calls in this area using the keyboard,

Table 1-8 Describes the Combination Key for Emergency Mode
Key Function
Ctrl"E Used to force the queues into emergency mode

Right click on a call in the Queues area and choosing an option from the context menu can also access

the above-mentioned options.

All Queues (F8)

This field displays calls that are waiting in queues. The calls are displayed with the following

information:
e Name of the caller

e Number of the caller

e Elapsed time the call has been waiting in queue

e Name of the queue (optional)

Figure 1-6 shows an example of the All Queue field.

[ oL-20131-01
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Figure 1-6 Displays the All Queue Field
[Fa] | Accounts Queus (1] |
Intemal
lyl 0:05

Queusl Oueus

Table 1-9 describes the functions that can be performed on the calls in this area using the keyboard,

Table 1-9 Describes the Function Keys for All Queues Field
Key Function
+

Answers the next incoming call.

Enter Press to answer the incoming call.

The above-mentioned options can be accessed through the right click context menu.

Active Calls (F7)

The Active Calls area displays calls that are being processed. You can view call information such as:

e Name of the queue

e Current status of the call, that is, Held, Calling, Talking or Busy

Figure 1-7 shows an example of the Active Calls area.

Figure 1-7 Displays the Active Calls area
[F7] | Active Calls |
Retrieved From Hold
Conference
Intermal John Smith

Default destination routing

Conference Cantroller

Talking

Internal 1000
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Directories

Interface W

Table 1-10 describes the keys that can be used in the Active Calls Area,

Table 1-10 Explains Keys Used to Handle Calls in Through Active Calls Area

Key Function

Enter Press to answer the incoming ringing call.

Enter Press to clear the connected call.

Enter Press to complete the Consult Transfer of the call.

PgDn Press to hold.

PgDn Press to retrieve the held call.

- Press to cancel Consult Transfer.

End Press to start and join all parties in Conference.

Delete Press to re-establish a call.

F2 Press to display Alternative Numbers, BLF and
Presence Status.

F12 Press for Contact Details

Home Press to park the answered call on a device.

Ctrl"M Used for sending an email to an extension user not

responding to a call

Right clicking on a call in the Active Calls area and choosing an option from the context menu can also

access the above-mentioned options.

There are two directories in Attendant Console:
e Internal Directory (F3)
e External Directory (F4)

Internal Directory (F3)

The Internal Directory provides a list of available internal extensions. For each contact, Internal

Directory displays:
e First Name
e Last Name
e Department
e Job Title

e Extension Number

e Email

These are the default settings and can be changed. Figure 1-8 provides an example of the Internal

Directory.

[ oL-20131-01
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Figure 1-8 Displays the Internal Directory Field

[ B INCTGETRBI T GTY A [F4] - External Directory

Lazt Hame First Hame Department Job Title Location

a | | | | |

| 2 | Murnber | Lazt Mamne | Firzt M arme | Department | Job Title

W & 8560 lires et Cuztomer Services Technical 5
- 542 e s Customer Services Praoduct con
i 8560 i finance and Administration Feceptionis!
- R4 il g L Development Softveare De
("] 5718 L] i Custarner Servies Suppoart Enc
(¥ 85598 gl aswaivt Customer Services Technical 5
=2 it A 1" Cuztomer Services Technical S

Call control operations can be performed on the contacts in the Internal Directory in the following ways:

e Using the mouse, select a contact in the directory and click any call control button on the call control
toolbar. These buttons have been explained in the previous sections.

e Right-click a contact and choose an option from the context menu.
e Use the keyboard shortcuts to perform call control operations as explained in the previous sections.

Table 1-11 provides a description of the icons that are used next to a contact in the Internal Directory
field. Table 1-12 describes the functions of the keys used within the Internal Directory field.

Table 1-11 Explains icons displayed next to contacts in the Internal Directory field

Icon Description

Indicates the Presence status of the Contact.

Indicates the status of the extension.

Indicates that the contact has some notes attached.

Indicates that an alternate number has been specified for the contact,or one of
the following fields have an entry in the Contact Numbers:

e Mobile

MERIE

e Business 1

e Business 2

e Home
Table 1-12 Explains keys used for functions within Internal Directory
Key Function
F2 Opens BLF, Presence Status and Alternative Numbers
F12 Opens Contact Properties.

External Directory (F4)

The External Directory provides a list of available external numbers for internal contacts. Figure 1-9
provides an example of the External Directory.
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Figure 1-9 Displays the External Directory Field
[F3] - Internal Directory LG Bl = (=10 11 B BT {=Te (a1, %
Last Mame Firgt Mame D'epartment Job Title
| 5 | MHumber I Lazt Mame | First Mame | Cepartment
" f"’-;} 2aE0 il LR Customner Services
- a542 L

P Custamer Services

Call control operations can be performed on the contacts in the External Directory in the following ways:

e Using the mouse, select a contact in the directory and click any call control button on the call control

toolbar. These buttons have been explained in the previous sections.

e Right-click a contact and choose an option from the context menu.

¢ Use the keyboard shortcuts to perform call control operations as explained in the previous sections.

Each External contact number displays an icon representing the type of telephone number such as
Mobile, Business, Home, with the contact’s First Name, Last Name and Company Name.

Table 1-13 provides a description of the icons that are used next to a contact in the External Directory
field. Table 1-14 describes the functions of the keys used within the External Directory field.

Table 1-13 Explains icons displayed next to contacts in the External Directory field
Icons Description
E'?I Indicates the Presence status of the Contact.
Indicates the type of contact number being used,
for example, E Mobile, Business, @ Home,
Fax or & Pager.
Z Indicates that the contact has some notes attached.
# Indi(fa.tes that an alternate number has been .
specified for the contact,or one of the following
fields have an entry in the Contact Numbers:-
e Mobile
e Business 1
e Business 2
e Home
Table 1-14 Explains keys used for functions within External Directory
Key Function
F2 Opens BLF, Presence Status and Alternative Numbers
F12 Opens Contact Properties.

Call Progress (F5)

The Call Progress field displays two types of calls:

Cisco Unified Business/Department Attendant Console User Guide
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e (Calls that are placed on hold.
e Timed-out (returned) calls that were transferred or parked on a device.
You can retrieve or re-establish a call from the Call Progress area in the following ways:

¢ Using the mouse, select a call in the Call Progress area and click any call control button on the call
control toolbar. These buttons have been explained in the previous sections.

e Right click a call and choose an option from the context menu.
e Use the keyboard shortcuts to perform call control operations as explained in the previous sections.

Table 1-15 provides a description of the fields displayed in the Call Progress area.

Table 1-15 Explains Fields Displayed for a Call in the Call Progress Area

Control Name Description

Call Progress Displays the caller’s number.

Time It is the elapsed waiting time of the caller.

Extension Extension for which the call was transferred.

Status This indicates whether you have placed the call on
hold, or, if the call has returned on time-out.

Label The label indicator is displayed to show that there

e are notes attached to the call.

Call Parking Devices Field

The Call Parking Devices field displays a list of call parking devices. By default you can view all
devices. Figure 1-10 displays an example of the Call Park area with all Park devices shown.
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Figure 1-10 Displays the Call Park area

%i‘ & 'ﬁv 'ﬁt Last call parked at: |3522 Parked For: I.luhn Smith
@ 8520 i@ e522 W 8524

@ 8521 @ 8523

Table 1-16 describes the buttons that are available in the Call Park area to restrict the view of the Call
Park devices.

Table 1-16 Explains Functionalities of the Buttons Available in Call Park Area
Button Function
Shows all Call Parking devices.

Displays Call Parking devices available to you.

Shows devices where you have parked calls.

1§i
= Show Call Parking devices where other operators
g have parked their calls.
Last call parked at. [8522 Displays the number where you parked the last
: call.
Sl | e When a call is reverted from a busy extension and

you park that call, Parked For field will display
the name of the contact the call bounced back
from.

A Call Park Device with ﬁ Out of Service icon indicates that the selected call park device is currently
out of service. In this case that device cannot be used for parking calls.

You can park or retrieve the Call Park area in the following ways:

¢ Using the mouse, select a device in the Call Park area and click any call control button on the call
control toolbar. These buttons have been explained in the previous sections.

e Right-click a device and choose an option from the context menu.

e Use the keyboard shortcuts to perform call control operations as explained in the previous sections.

Speed Dial Field (F6)

To enable you to quickly dial calls, a field is provided for frequently called numbers. Figure 1-11
displays an example of a name in the Speed Dial area.

Cisco Unified Business/Department Attendant Console User Guide
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Figure 1-11 Displays the Speed Dial Area

Mumber Company

aEa0T11 John Smith Compard,

You can perform call control operations in the following ways:

e Using the mouse, select a contact click any call control button on the call control toolbar. These
buttons have been explained in the previous sections.

e Use the keyboard shortcuts to perform call control operations as explained in the previous sections.

Adding an entry to the Speed Dial Field

To add a number to the Speed Dial field, perform the following steps:

Procedure

Step 1 Point the cursor in the Speed Dials field and right click to select Add Speed Dial. Figure 1-12
demonstrates the right click menu with Add Speed Dial selected.

Figure 1-12 Displays the Menu Option to Add a Speed Dial Number

Zall
Consul

Blind Transfer

C=

Complete Transfer

| add Speed Dial. ..
Edit Speed Dial, ..

Delete Speed Dial...

Step2  Enter Number, Name and Company name of the contact. Figure 1-13 displays the Speed Dial window.
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Figure 1-13 Displays the Window Where Speed Dial Information is Added

Speed Dial

? Enter the number, name and company far this speed dial.

MOTE: & private speed dial can only be viewed and changed
by o

[+ Private Speed Dial

Murmber: |555m 1

2 x|

M arne: IJ ahin Sith

Cormpany: Il:l:lmpany.-“-‘-.

Help

The Table 1-17 provides a description of the fields that appear in the Speed Dial Window (shown in

Figure 1-13).

Table 1-17 Explains the fields displayed on the Speed Dial window

Field

Example

Description

Private Speed Dial

Private speed dial numbers can only be edited
and viewed by you. Other users logging into
the application will not be able to view the
numbers for which this checkbox is selected. If
unchecked it will be visible to ALL other
users.

Number 5550111 Contact number to be saved as speed dial.

Name John Smith Name of the contact.

Company CompanyA Name of the company where your contact
works.

Click OK.

You can simply drag and drop a contact from the Internal/External Directory fields to the Speed Dial

area.

Deleting an entry from the Speed Dial Field

Step 1

To delete an entry from the Speed Dial field, perform the following steps:

Procedure

Select the speed dial you want to delete.

[ oL-20131-01
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Step2  Right click and choose Delete Speed Dial. Figure 1-14 displays the right click menu with the option to
Delete Speed Dial selected.

Figure 1-14 Displays the menu option for deleting a speed dial number

Call
g Consul:

P Elind Transfer
g Complete Transfer

add Speed Dial. ..
[FE] I Mumber I M ame Edit Speed Dial. ..
4 o100 K.ap k.aren Delete Speed Dial. .. |
B5E0111 John Srith LOmpard,

Step3  Click Yes on the confirmation message. Figure 1-15 shows the Remove Speed Dial confimation box.

Figure 1-15 Displays the message that appears to confirm a speed dial deletion

Remove Speed Dial x|

@ Are wau sure you wank ko remove this speed dial?

Updating an entry in the Speed Dial field

To update an entry in the speed dial field, perform the following steps:

Procedure

Step 1 Select the speed dial you want to update.

Step2  Right click and choose Edit Speed Dial. Figure 1-16 shows the right click menu with Edit Speed Dial
selected.
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Figure 1-16 Displays the menu option to edit a speed dial number

Call
Consul:

Blind Transfer

C e

Complete Transfer

add speed Dial, ..

: | : :
[FE] | Murnber | Mame | Edit Speed Dial...

<= 0100 Kap ka Delete Speed Dial. .,

BEE0T11 John Srmith Compatd,

Step3  Change the Name, Number and Company as required.
Stepd  Click OK.

Working in the Fields

Here are some procedures you can use while working in Attendant Console,

Dialing a Number

Instead of selecting a contact from the directories and then making a call, you can dial a number yourself
to make a call as well. All you have to do is enter the digits using your keyboard. As you type, the digits
will appear in the Calling box under the Active Calls area. Figure 1-17 displays the calling box where
the dialled number appears, in this example ‘2000’.Table 1-18 lists the available keys that can be used
to edit a dialled number.

Figure 1-17 Displays the calling box where the dialled number appears

2000

The following keys can be used,

Table 1-18 Lists the keys used to edit the dialled number

Key Function

Backspace Clears digits when typing a contact number
Space Bar Clears the number while dialing out.

Enter Dials the entered number.

Finding Contacts in the Directories

One of Attendant Console’s most powerful features is the search engine. It enables you to search for a
specific person via configured criteria within the Internal and External directories. This feature is a
necessity if the console is extremely busy.

Cisco Unified Business/Department Attendant Console User Guide
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To locate aperson or number, perform the following steps:

Procedure

Step 1 If necessary, press the relevant F-Key to select the Internal Directory (F3) or External Directory (F4).
This will place the cursor in the first box ready for the search. Also if you start typing the cursor will
automatically go to the first search box.

Step2  You can select any search criteria. You can base your search on any of the following:
e Last Name
e First Name
e Department
e Number

Step3  Press the Tab key on the keyboard to jump between the search fields or point and click the mouse on the
relevant search box.

Stepd  Enter a keyword.
Step5  Press Enter.

The selected directory will filter out any contacts that do not match the keyword that is entered.

Once the required person has been located, either double click or press the Connect key twice to call the
contact. Figure 1-18 shows an example of a search for people that have ‘John’ as a first name.

Figure 1-18 Displays the results for the search applied using the filters

L Il LT R =1 a1, TA  [F4] - External Directory

Lazt Hame Firzt Mame Department
& I I Jahkin I
_ﬂ I | R | MNumber | Lazt Mame | First Mame | Department I Job Tit
@ ] & 100 Smith John Sales
- = 2000 Jurior Jahn b arketing

Note  Search will filter contacts that do not match the criteria if the Filter Search button & is pressed. If this
button is not pressed the application will only select the contact that match the given keyword. For
instance, if the Filter Search button &% is pressed and you type "A" then the first contact that has its
first letter "A" will be selected.
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Customizing Attendant Console

Revised: October 9th, 2009

Cisco Unified Business/Department Attendant Console provides the ability to customize both the
appearance and functionality of the application.

To access the console settings, choose Options > Preferences in the main menu. This will open the
Preferences window. The tabs in this window are explained in the following sections,

The following settings are available in this section:

Popup Application When

Attendant Console provides you the options to pop up the application when:
¢ Queued calls are waiting to be answered
e My local device rings (if this is the device you are logged in with)
e Minimize when not in use

If either or both of the first two options are checked, the application will pop up on your desktop if it is
minimized. The third option will minimize the application when there are no calls active or queuing.

Figure 2-2 displays the options that can be configured from the General tab.

Figure 2-1 Displays the General Tab in the Preferences Section

Frimary Server | Frezence I Logaing
Secondary Sort | Filker Search

Drigplay | Internal Directony I Euternal Directorny I Field Headerz

Diallingl EallTransfersI Call F'arkl kute I Tones

Fopup Application when

[v Oueued calls are waiting to be answered
v My local device rings

[T Minimize when not in use
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Dialling

The following option is available in this tab,

¢ YVoicemail Prefix —This option allows you to enter a prefix that will send the call directly to a
voicemail extension.

e Auto Dial — This option allows you to automatically dial an internal or external number after a
defined time. You can set the duration of time for Auto Dial. The desired number is entered in the
area below Active Calls.

Figure 2-4 displays the options that can be configured from the Dialling tab.

Figure 2-2 Displays the Dialling Tab in the Preferences Section
Frimary Server I Frezence | Logaing
Secondary Sort I Filker Search
Dizplay | Irternal Directony | Esternal Directon | Field Headerz

General
— Yoicemail
Yoicemail prefis: I
= Auto Dial
Aty Dial Lelay
Slow | J Fast
2 Senonds

Call Transfers

The following option is available in this tab,

When Dragging and Dropping or Double Clicking

This section allows you to choose the type of transfer you would like to perform when dragging and
dropping or double clicking a call. You can click a radio button to choose one of the following options:

e Perform consultation transfer
e Perform blind transfer

Figure 2-6 displays the options that can be configured from the Call Transfers tab.
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Figure 2-3 Displays the Call Transfer Tab in the Preferences Section

foreferences 2

Frimary Server I Frezence I Logairg
Secondary Sort I Filter Search
Dligplay I [nternal Directony | External Directorny | Field Headerz
| Call F'arkl b uite I Tones

General I Diialling

ETE T T T T TT T TR PP PO .

YWhen Dragging and Dropping or Double Clicking
{* Perform consultation transber
" Perform blind transfer

Call Park

This tab provides a checkbox. If you check the checkbox, after a call has been parked, all park devices
will be displayed in the Call Park Area.

Figure 2-8 displays the options that can be configured from the Call Park tab.

Figure 2-4 Displays the Call Park Tab in the Preferences Section

forctorences 2

Primary Server I Frezence I Logaing
Secondary Sort I Filter Search
Dizplay | [nternal Directary I Esternal Directony | Field Headers

Generall Diallingl Call Transfers | i Mute I Tanes

After a call has been parked
|7|7 Show all park. devices

Mute

This section allows the user to enable automatic muting of calls. The User can select any of the following
options:

¢ Performing a search — Selecting this checkbox will automatically mute a call when the operator
clicks in any of the search fields.

¢ Pressing numeric keys to dial numbers — Selecting this checkbox will automatically mute a call
when the operator dials a number.

¢ Changing or selecting Directory screens — If the user selects this checkbox, a call will be
automatically muted if the operator clicks on the directories.

Figure 2-10 displays the options that can be configured from the Mute tab.

Cisco Unified Business/Department Attendant Console User Guide
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Figure 2-5 Displays the Mute Tab in the Preference Section.
Filter Search I Prirary Server I Prezence I Logaing
Alternate Mumbers I Field Header= I Secondary Sort
Digplay I |nternal Direchany I E sternal Directom

Autarnatically Mute Callz When

[T Perfarming a search
[T Pressing numenc keps to dial numbers

[~ Changing or selecting Directary screens

Tones

This section allows for Tones to be switched on or off depending on specific events happening. The
Tones are then made by the attendant console when the events occur.

The following options are available in this tab:

e When I have made myself unavailable — This option has a checkbox Do not play any tones. Check
this option, if you require that the application does not play any tone while you are temporarily
absent from the Console Attendant.

e When a queued call is waiting to be answered — This option has a checkbox Play a Ring Tone.
Check this option, if you require playing a tone while a call is waiting in a Queue.

e  When a call has timed out — This option has a checkbox Play a Ring Tone. You can check this box
to signify the reverted call from the Call Progress Field, Call Parking Field or other.

Figure 2-12 displays the options that can be configured from the Tones tab.

Cisco Unified Business/Department Attendant Console User Guide



| Chapter2 Customizing Attendant Console

Display M

Figure 2-6 Displays the Tones Tab in the Preferences Section

Primary Server I Presence I Logging
Secondary Sort I Filker Search
Dizplay I Internal Directony I Esternal Directony I Field Headers
Eenerall Diallingl EaIITransfersl Call F'arkl Mute E

—%hen | have made myzelf unavailable

[ Da not play any tones

—%hen a queued call iz waiting to be answered

[+ Play a Ring Taone

—%hen a call has timed out

[+ Play a Ring Taone

Display

The Display tab allows you to set the display settings of the font, tag and reverted reasons. It has the
following three segments:

e When a section becomes selected — This setting allows you to change the font colors of the labels
in Attendant Console for the selected area. This makes it easy to see which area you have selected
when operating the console.

¢ Display Call Information — The Show Routing Tag setting allows you to display the intended
destination of each call as well as the standard details with each call such as Caller ID and
internal/external notification. Show Time-out Conditions will include details of why a call has
returned to the operator.

¢ When Making Calls — This settings will enable/disable the BLF/Presence prompt being displayed.

e When dragging and dropping — The Display a drag image option allows you to see a complete
image on screen of the call you are dragging across the screen.

Figure 2-14 displays the options that can be configured from the Display tab.
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Figure 2-7 Displays the Display Tab in the Preferences Section

Frimary Server I Frezence I Logairg
Secondary Sort I Filter Search

Diallingl EallTransfersI Call F'arkl P it I Tones

il Internal Directary I External Directany I Field Headers

— “When a zection becomes zelected

[T Change fant Calaur

To thiz colour: . I:-:n_h:uurl

— Dizplay Call Information

[T Show Routing Tag
[v Show Timeout Conditions

— When making callz

[¥ Prompt if Presence Status is set

— "When dragaing and dropping
[ Dizplay & drag image

Internal Directory

The Internal Directory is a set of the Internal extensions. Through this tab, you can set the way these
extensions appear in Cisco Unified Attendant Console. It has the following three segments:

¢ Default Display Order — You can set the Default Display Order in Internal Directory. The drop
down list consisting of default values is used for selection. The contact list in the directory will be
sorted according to the selected option.

¢ Show the following information — This section has two list boxes with Available and Displayed
values. You can select values from the Available and insert them in the Displayed list box. The
selected information will be displayed for a contact.

¢ Search Based On — In this segment, you can choose the search fields required to display, which will
be used to search a record in the Internal Directory.

Figure 2-16 displays the options that can be configured from the Internal Directory tab.
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Figure 2-8 Displays the Internal Directory Tab in the Preferences Section

Frimary Server I Frezsence I Logaing I
Secondary Sort I Filter Search
General | Dialing | EallTrapsfersI Cal F'arkl Mute I Tn:nnesl
Display i Internal Direchary I Extermal Directary I Field Headers

.............................................

— Default Dizplay Order

ILast Mame j

— Show the fallawing information
Auvailable: Dizplayed:

Diefault Presence lcar Phaore Status leon
E mail Motes lcon
Murnber

3| |Lazt Hame

Firzt Mame

=
Department E

Job Title

1

(ES

— Search Bazed On
Search 1: I Last M ame j
Search 2 IFirst Mare j
Search 3: IDepartment j
Search 4; INumI:uer j

Fields that are greyed out denote that they are not indexed within the database.

Cisco Unified Department Attendant Console provides only three search options.

External Directory

The External Directory is the list of External numbers for internal contacts. Through this tab, you can
set the way these extensions appear in Attendant Console. It has the following segments,

e Default Display Order — You can set the Default Display Order in External Directory. The drop
down list consisting of default values that can be selected. The contact list in the directory will be
sorted according to the selected option.

e Show the following information — This section has two list boxes with Available and Displayed
values. You can select values from the Available and insert them in the Displayed list box. The
selected information will be displayed for a contact.

¢ Search Based On - In this segment, you can choose the search fields required to display, which will
be used to search a record in the External Directory.

[ oL-20131-01
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Figure 2-18 displays the options that can be configured from the External Directory tab.

Figure 2-9 Displays the External Directory Tab in the Preferences Section

Frimary Server | Frezence I Logaing
Secondary Sart I Filker Search
Generall Diallingl Call Transfers | Call Park | Mute I Tones
Dizplay I Internal Directary | External Dirsctory | Field Headers

— Default Dizplay Order

ILast M ame j
— Shaow the following information
Bxrallable: Dizplayed:
Default Prezence lcor Phone Status ook
Department _>| Mates lcon
Ernail Last Mame
Job Title 53] [First Name

Type Hurmber

4
Bl &

>k
o

— Search Bazed On

Search 1: ILast Mame j
Search 2 IFirst Mame j
Search 3: IDepartment j
Search 4; INumI:uer j

Note  Fields that are greyed out denote that they are not indexed within the database.

Note  Cisco Unified Department Attendant Console provides only three search options.

Field Headers

You can change the text of Field Headers that appear in the application by simply entering new Display
Text to replace the Default Text.

To change the Display Text for Field Headers, perform the following steps:
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Procedure

Step 1 Click on a value in the Display Text column.

Step2  Type a new Display Text to replace the Default Text.
Step3  Click OK.

To restore default text, click the Restore Defaults button.

Figure 2-21 displays the options that can be configured from the Field Headers tab.

Figure 2-10 Displays the Field Headers Tab in the Preferences Section

Frimary Server I Frezence I Logaing I
Secondary Sort I Filter Search

Generall Diallingl EallTransfersI Call F'arkl b uite | Tu:unesl

Drigplay I Internal Directony I Euternal Directory  Field Headers

You can change the names of the field headers that appear in
the application by simply entering the new name of the field
next ko the field name pou wizh to change.

[f at ary time you are not happy with the names pou have
azzigned, pou can restore ther back. to the default zettings by
prezzing the Restare Defaults button,

Drefault Text |I:Ili3|:||a_l.I Test |
Firzt Mame

Last Mame Last Mame

Ernail Ernail

Job Title Job Title

Department Department

Eestore [Defaults

Secondary Sort

This tab is enabled only when Attendant Console is logged out.
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You can customize the way Attendant Console sorts and searches the data by specifying a Secondary
Sort Column.

You can restore defaults if required. The Restore Default button enables when a value is changed from
the Secondary Sort Column.

To change the values in Secondary Sort Column, perform the following steps:

Procedure

Step 1 Click on a value in the Secondary Sort Column.

Step2 A drop down menu will appear with different values related to the values in the Sort Column.
Step3  Choose a value to replace the previous one.

Step4  To change more than one value, repeat steps 1-3.

Step5 Click OK.

Figure 2-23 displays the options that can be configured from the Secondary Sort tab.

Figure 2-11 Displays the Secondary Sort Tab in the Preferences Section
Frimary Server I Frezence I Logaging

Generall Diallingl EallTransfersI Call F'arkl b Lite I Tones

Drigplay | [nternal Directary | Esternal Directony | Field Headers
Secondary Sart I Filker Search

— Secondany Sort

MOTE: You can only change the secondary
zort if you are logged out.

Youcan custamize the way the application zart and
searches fion data by specifiving a zecondary sark
colurin,

[ &t anytime yow decide youw are ot happywith the
gecondany 2ort colurmne pouw bave aesigned, pou
zar retur them to the default 2ettings by clicking
thie ‘Hestore Defaults’ Guttar,

Sort Calumn | Secondary Sort Colurnr a
Title Last Mame

| ritialz Last Mame

First M ame Last Mame |-
kiddle Hame Last Mame

Last Mame Compary

Email Last Mame

Email 2 Last Mame

Email 3 Last Mame

Addresz Line 1 Last Mame il
4| | 3

Hestore [efaulks |
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Filter Search W

Filter Search

As you search in any of the search fields with either the Internal or External directories, you can specify
how you want the search to perform on screen. This tab allows you to set those preferences by selecting
the following options,

When Performing a Filter Search

¢ Press Enter to perform search — Once you have entered some information in any one of the search
fields, selecting this option would perform a search when you press the Enter key.

e Search after every key press — This option, when selected, refreshes the search results with every
key you press to enter a search value in the field.

¢ Search after a delay — If this option is selected and you enter information in the search field, the
search result will be displayed with a delay specified in the Search Delay section.

Figure 2-25 displays the options that can be configured from the Filter Search tab.

Figure 2-12 Displays the Filter Search Tab in the Preferences Section
Frimary Server I Presence I Logging

Generall Diallingl EallTransfersI Call P'arkl kute | Tones
Digplay I Internal Directory I External Directony | Field Headers
SECDI"IEIEI[_'.-' Sart Filter Search

— "When Performing a Filker Search
% Press Enter to perform searchi
i Search after eveny key press
= Search after a delap

Search Delay

Senohds

1 J ]

1 Second

Primary Server (Information only)

This tab is for information only. It tells you the Server to which you are connected, and the status of that
connection.

Figure 2-27 displays the options that can be configured from the Primary Server tab.
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Figure 2-13 Displays the Primary Server Tab in the Preferences Section
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{* | Serven Name IIMFI.-‘E-.N.-’-‘-.-ELI BAC
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Caprest |
g Active Status:  Active .ﬁ.ctixatel

Presence

This tab provides the Operator with the facility to set the preferences for the Presence information.
e Default Presence Display — Select between either Cisco Presence Status or None.

¢ Enable Cisco Presence Information — To display the Cisco Presence Information tick this box and
select which field will be used to retrieve the information.

The selection is made via a drop down selection with the choices being:- Email, Email 2, Email 3, User
Field 1, User Field 2, User Field 3 or User Profile.

Figure 2-29 displays the options that can be configured from the Presence tab.
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Figure 2-14 Diplays the Presence Tab in the Preferences Section
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Logging

This tab provides for logging files to be switched on and off.

Figure 2-31 displays the options that can be configured from the Logging tab.

Figure 2-15 displays the Logging Tab in the Preferences Section

Generall Diallingl EallTransfersI Call F'arkl Mute I Tores
Dizplay | Internal Directony | Esternal Directon | Field Headers
Secondary Sort I Filter Search
Frimary Server I Frezence Logging

Logging Infarmation

[~ Server Communicatior:

Log path and filename:
C:AFrogram FileshCizcohLogging OFPRYLoghO PR log.txt

Logging W
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Using Attendant Console

Revised: October 9th, 2009,

As the heading demonstrates, this section is about the operational flow of the application. It covers the
topics relating to call management. In this section, you are given instructions on how to work within
Attendant Console. There are two levels of monitoring that can be displayed within Attendant Console,
Phone and Line Status. The icons shown in Table 3-1 appear in the Directories and reflect the Phone

Status.
Table 3-1 Lists Icons Used to Reflect the Phone Status shown in the Internal Directory
Icon Description
On-hook.
J Active
= Unavailable.
Ringing in

Answering Calls

Attendant Console attends two types of calls,
¢ Internal Calls — that are received from a local extension
e External Calls — that are received from an external number

Calls that are being attended appear in the Active Call Area (F7). Table 3-1 shows an example of a call
in the Active Calls area.

Cisco Unified Business/Department Attendant Console User Guide
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Figure 3-1 Calls Displayed in the Active Calls Area

[F7] | Active Calls
Retrieved From Hold
Conference
Internal John Sroith gL
Default destination rauting

Conference Controller

Talking

|ntermal 1000

The calls coming into the system are prioritized and queued in the All Queues Area (F8). Calls can be
answered using the following two methods,

e Answer Next — Answering the next call in queue.

¢ Cherry Picking — Selecting a particular call from the queue to answer.

Answer Next

Incoming calls are prioritized by the system before being displayed on screen. Calls are then displayed
in the Queued Calls Area (F8) in descending order of priority.

Answer Next is the easiest way to answer incoming calls. This option answers calls in the order of
priority set by the system. The top priority calls are answered first.

To answer the next call using the keyboard, perform the following steps:

Procedure

Step 1 Press F8 to select the Queued Calls Area.

Step2  Press the ‘+’ key on the keyboard and the call will be delivered to your handset.
To answer the next call using the mouse, perform the following steps:

Procedure

Step1  Right-click in the Queue Area.

Cisco Unified Business/Department Attendant Console User Guide



| Chapter3 Using Attendant Console

Answering Calls

Step 2 From the context menu, choose Answer Next.

The following image illustrates how you can use the context menu to answer the next call. The call with
the next highest priority will be answered irrespective of which call is selected in the All Queues Area.
Figure 3-2 displays a call being answered through the Answer Next option.

Figure 3-2 Displays Calls Being Answered Through the Answer Next Option
[F2] [ AN Queues (3]
Internal
1403

GUEUE 2 Queue

[nternal
14I-IE Obl -1 AGE 4

QUELE m
.
Internal Al

045 |

AUELE 2 Queus

Cherry Picking
N

Note  This section does not apply to Cisco Unified Department Attendant Console as the queues are not
displayed.

The incoming calls being displayed can be cherry picked from a specific queue as required .
In order to answer a call you must select a queue and then select the call you wish to answer.
To select a queue using the keyboard, perform the following steps:

Procedure

Step 1 Press F9 to select the Queues field.
Step2  Use the up and down arrow keys to select the required queue.

Step3  The F8 field will display the calls that are waiting in the selected queue.

Note  To revert back to seeing all calls from all Queues, select All Queues icon from F9.

If you are using a mouse, simply click on a queue in the Queues field. After selecting the queue, you are
ready to take waiting calls.

To answer calls in the selected queues, using the keyboard, perform the following steps:

Procedure

Cisco Unified Business/Department Attendant Console User Guide
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Step1  Select the All Queues field by pressing the F8 key.
Step2  Using the up and down arrow keys, select the call to answer.

Step3  Press Enter key to connect the call.

To answer calls in the selected queue using a mouse, perform the following steps:

Procedure

Step1  Select the All Queues field.
Step2  Click on the relevant call.

Step3  Click the s Answer Call button in the call control tool bar.

A personal call direct to your extension will show in the éétive Calls field, and ring your handset. You
can answer by picking up the handset, or by clicking the #= Answer Call button.

S

Note  You can simply drag and drop a call from the All Queues field to the Active Calls area to answer.

Alternative Numbers and Presence Status

This Status screen can be triggered in two ways:
e If a contact is selected from a Directory and F2 is pressed.

e If an operator transfers a call to an extension with a presence status assigned. This will prompt the
user that the person the call is being forwarded to currently has a presence status set. Table 3-2
shows the details that will be available in the Presence Status Window.

Table 3-2 Details available in the Alternative Presence Status Window
Control Description
Phone Status Displays the current status of the contact. The phone state is represented by

phone status icon and text.

Summary Panel This panel will show Phone Status, Cisco Presence and Contact Notes. These
can be highlighted and the status explained in the Detail Panel.

Detail Panel The contents of this panel change to show the particular status requirement
selected in the Summary Panel.

With Phone Status selected in the Summary a list of the individual lines
linked to the contacts phone will be displayed.

Alternative Contact This specifies the number to which the call must be forwarded. If the number
Details is saved in the internal or external directory, contact's full name will be
displayed instead of the number itself.
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Step 1
Step 2

Step 3

Answering Calls

The icons that denote the Line Status are shown in Table 3-3.

Table 3-3 Lists Icons Used to Reflect the Line Status

Icon Description

On-hook.

Off-hook.

el Unavailable.

=2 Ringing in

= 4 Ringing out

Ringing out on busy extension

i
L=

Connected

<

Call on hold

Call forwarding

Notes

3 q{-.

Contact not in BLF.

To transfer call, perform the following steps:

Procedure

Select a contact from Alternate Contact Details.
The operator can click on any of the following options as required:
e Answer Call

e C(Call

e Consult Transfer

e Blind Transfer

e Transfer to Voicemail

e Hold

e Hold with Notes

e Start Conference

e Park Call

Click Close to cancel.

Table 3-4 shows the available keystrokes that can be used in order to make the desired transfers:

Table 3-4 Keystrokes for transferring a call

Key Description

Enter The call is consulted to the selected alternative
number.

Enter + Enter The call is blind transferred to the selected
alternative number.

[ oL-20131-01
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In Figure 3-3 the Alternative Numbers/Presence Status image shows a phone device that has two lines

linked to it. This example does not have a Presence Status set and has been triggered by pressing the F2
button.

Figure 3-3 Alternative Numbers/Presence Status Window
Alternate Numbers For & asis Sss - [Unknown]

Presence Status Details

Phaone Status
Summary —
S W Idle
| Directany Mumber Status I
Cisco Presence 1100 Or haok
2 Unknown 1002 On hook
Contact Nates
Alternate Cantact D etails
I @ | Type Last Mame First Mame Department Mumber
Main Extenzion Toreh e Engineering 1002
|

LClose |

Transfer Calls

After answering the call, you can transfer it to a requested device, contact or external number. A transfer
can be made either as a blind or consult (announced) transfer. Calls can be transferred to any available
destination either internally or externally.

Transferring a call is straightforward using the mouse or the keyboard and can be completed by either

entering the desired extension number (if known), or searching the internal or external directories for the
correct contact.

Initiating A Blind Transfer

A blind transfer is a call that is transferred without consulting the recipient.

[l Cisco Unified Business/Department Attendant Console User Guide
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Transfer Calls

Blind Transferring to a Known Number

Step 1
Step 2

Step 3

Step 1
Step 2

Step 3
Step 4

To blind transfer a call to a known number using the keyboard, perform the following steps:

Procedure

Answer a call or select the call in the Active Calls field.

Type in the destination number (internal or external). The cursor will automatically be placed in the Dial
Box (see Figure 3-4 which shows an example of the Dial Box with the number ‘2000’ displayed):

Figure 3-4 Displays the Dial Box Where the Dialed Number is Displayed

' 2000

Double Press the ENTER key quickly to transfer the call.

To blind transfer a call to a known number using a mouse, perform the following steps:

Procedure

Answer a call or select the call in the Active Calls field.

Using the keyboard type in the destination number (internal or external). The cursor will automatically
be placed in the Dial Box.

¥
Press Transfer. This will initiate the transfer.

>
Press Transfer again to transfer the call.

Blind Transferring to a Directory Contact

Step 1
Step 2

Step 3

Step 4

If the extension number of the desired recipient is not know you can easily search the Directory to find
the correct contact. Both the Internal (F3) and External (F4) directories allow searches to be made via 3
search fields.

To blind transfer a call to a Directory Contact using the keyboard, perform the following steps:

Procedure

Answer a call or select the call in the Active Calls field.

If searching for a contact using the first displayed search field, simply start typing. The cursor will
automatically move to the first search field. If you need to use a search field that isn’t the first on the
screen, use the TAB key to find the right field to type into.

As you type, the directory will shrink as contacts are matched (Depending on how Filter Search is
configured, See 2 <$volnum>“Filter Search”’page 2 - 12). Keep typing until the required contact is
found, or use the up or down arrow to highlight the contact.

Double-click the Enter key to transfer the call.

[ oL-20131-01
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To blind transfer a call to a Directory Contact using the mouse, perform the following steps:

Procedure

Step 1 Answer a call or select the call in the Active Calls field.
Step2  Click into the required Search field in either the Internal or External Directory.

Step3  Start typing and as you type the directory will shrink as contacts are matched. Keep typing until the
required contact is visible and use the mouse to select the desired contact

Stepd  Double-click the contact to initiate the transfer.
>
Step5  Press Transfer to transfer the call.
Or

Step 1 Point the mouse at the relevant call within the Active Calls field.
Step2  Press the left mouse button.

Step3  Whilst holding the mouse button down, drag the call to the relevant destination within the Internal or
External Directory field and then release mouse button.

Or

Step1  Select call details that are displayed in the Active Calls field.

Step2  Point the mouse at the relevant destination within the Internal or External Directory or Speed Dial
fields and click the right mouse button to reveal a Popup menu.

Step3  From the popup menu choose Call.
Step4  Ensure that the call initiated is selected within the Active Calls field.

Step5  Click the Complete Transfer button.

Initiating a Consult Transfer

In this case, the destination of the transfer is consulted before the actual transfer takes place.

Consult Transferring to a Known Number

To consult transfer a call to a known number using the keyboard, perform the following steps:

Procedure

Step 1 Answer a call or select the call in the Active Calls field.

Step2  Type in the destination number (internal or external). The cursor will automatically be placed in the Dial
Box (Figure 3-5 shows an example of the Dial Box with the number ‘2000’ dialled):
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Step 3
Step 4

Step 1
Step 2

Step 3
Step 4

Transfer Calls

Figure 3-5 Displays the Dial Box Where the Dialed Number is Displayed

2000

Press the ENTER key to make the enquiry call.

After consulting with the destination press the ENTER key to complete the transfer.

To consult transfer a call to a known number using a mouse, perform the following steps:

Procedure

Answer a call or select the call in the Active Calls field.

Using the keyboard type in the destination number (internal or external). The cursor will automatically
be placed in the Dial Box.

] . e e
Press Transfer. This will initiate the transfer.

>
Press #= Transfer again to transfer the call after consulting.

Consult Transferring to a Directory Contact

Step 1
Step 2

Step 3

Step 4
Step 5

Step 1
Step 2
Step 3

If the extension number of the desired recipient is not know you can easily search the Directory to find
the correct contact. Both the Internal (F3) and External (F4) directories allow searches to be made via 3
search fields.

To consult transfer a call to a Directory Contact using the keyboard,

Answer a call or select the call in the Active Calls field.

If searching for a contact using the first displayed search field, simply start typing. The cursor will
automatically move to the first search field. If you need to use a search field that isn’t the first on the
screen, use the TAB key to find the right field to type into.

As you type the directory will shrink as contacts are matched (Depending on how Filter Search is
configured, See 2 <$volnum>“Filter Search”page 2 - 12). Keep typing until the required contact is
found, or use the up or down arrow to highlight the contact.

Press the ENTER key to initiate the enquiry call.
Press the ENTER key again to complete thet transfer.

To consult transfer a call to a Directory Contact using the mouse, perform the following steps:

Procedure

Answer a call or select the call in the Active Calls field.
Click into the required Search field in either the Internal or External Directory.

Start typing and as you type the directory will shrink as contacts are matched (Depending on how Filter
Search is configured, See 2 <$volnum>“Filter Search”page 2 - 12). Keep typing until the required
contact is visible and use the mouse to select the desired contact

[ oL-20131-01
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Step 4
Step 5

Step 1
Step 2
Step 3

Step 4

Step 1
Step 2

Step 3
Step 4
Step 5

Double-click the contact to initiate the transfer.
>
Press Transfer to transfer the call after consulting.

Or

Point the mouse at the relevant call within the Active Calls field.
Press the left mouse button.

Whilst holding the mouse button down, drag the call to the relevant destination within the Internal or
External Directory field and then release mouse button. This sets up the enquiry call.

>
Press Transfer to transfer the call after consulting.

Or

Select call details that are displayed in the Active Calls field.

Point the mouse at the relevant destination within the Internal or External Directory or Speed Dial
fields and click the right mouse button to reveal a Popup menu.

From the popup menu choose Call.
Ensure that the call initiated is selected within the Active Calls field.

Click the Complete Transfer button.

If a transferred call is not answered within a certain time duration, the call is reverted back to the Active
Calls Area. These calls can then be handled through Reverted Call Controls explained in the latter part
of the guide.

Making Calls

Cisco Unified Business/Department Attendant Console allows you to dial and make calls. Calls can
either be made directly to a contact or can be made using different call controls such as Call Parking,
Transferring and Conference. These call controls are explained in detail, see 1 <$volnum>“Displays
Call Control toolbar options”page 1 - 8. There are two types of call that can be made,

¢ Internal Call — Calls that are made to the numbers existing within the system. For example, in a call
centre, calls made to the numbers within the call centre are called internal numbers.

e External Call — Calls that are made to the numbers external to the system. For example, an operator
in a call centre can make a call to a customer for marketing purposes.

Make an Internal Call

Step 1

To call a local extension, perform the following steps:

Procedure

Enter the required number. No matter which area of the console you have selected, as you type, the digits
will appear in the Calling box under the Active Calls area.
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Placing Calls on Hold

Step2  Press Connect/Clear with the mouse or Enter key using the keyboard.

A call will be initiated for the selected contact and the details will be displayed in the Active Calls area.

Making External Calls

To make an external call using a keyboard, perform the following steps:

Procedure

Step 1 Dial the number of the access code and then the external number. (Unless the Attendant Console is
configured to add the Access Number. This is done on the Cisco Unified Business/Department Attendant
Admin).

Step2  Press Enter key to start dialing.

It is not necessary to place the cursor in the Calling Box, when you start typing the numerical values, it
will automatically type in it.

To make an external call using a mouse, perform the following steps:

Procedure

Step1  Select the External Directory using the mouse.

Step2  Double click on the number to dial.

Placing Calls on Hold

While answering a call, Cisco Unified Business/Department Attendant Console can place the active call
on hold to answer other incoming calls. The call is held on a Service Queue for the time period set as
Hold Recall Time in Cisco Unified Attendant Admin. After the Hold Recall Time elapses, the status
of the call will change from Held to Hold Timeout. These calls can be handled through Reverted Call
Controls explained in the latter part of the guide. A call can be reverted whether the Timeout has been
reached or not.Figure 3-6 shows an example of a call on hold in the Call Progress Area.

Figure 3-6 Displays a Call On Hold in the Call Progress Area

[F5] | Call For W ait Time Call from Status

&= 1001 | | 2000

Accounts Hueue

The call will be shown in the Call Progress area and retrieved to the Active Calls area at any time.

To hold a call through the keyboard, perform the following steps:

Cisco Unified Business/Department Attendant Console User Guide
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Procedure

Step1  Press F7 key to select Active Calls area.
Step2  Select a call using up and down arrow keys.

Step3  Press the (Page down) key to hold the selected call.

To hold a call using a mouse, perform the following steps:

Procedure

Step 1 Select a call in Active Call field.
Step2  Click the "8 Hold button.

Retrieving Held Calls

Calls placed on hold can be retrieved from the Call Progress area to Active Calls area. Calls reverted
from Hold, Park and Transfer can also be seen in Call Progress area.

To retrieve a held call using keyboard, perform the following steps:

Procedure

Step 1 Press F5 key to select Call Progress area.
Step2  Select a call using up and down arrow keys.

Step3  Press the (Page down) key to retrieve the held call.

To retrieve the held call using mouse, perform the following steps:

Procedure

Step1  Click on a held call in the Call Progress area.
Step2  Click the 7z Retrieve button.

Muting Calls

Cisco Unified Business/Department Attendant Console provides the ability to mute a call when certain
actions are being undertaken. There are two types of Mute, the first is automated and is set via the
Preferences > Mute tab. If this has been enabled it can include when a search is being made, when a
number is being dialed, or if you are changing or selecting Directory screens.

The second type of muting a call is manual and is instigated either by pressing the Mute button ( ﬁ )
or pressing Ctrl*Q. The same key combination will also un-mute a call. Alternatively you can right click
on the active call and select Mute from the menu.
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Call Parking

Step 1
Step 2
Step 3

Step 1
Step 2

Step 1
Step 2

Cisco Unified Business/Department Attendant Console provides you with the ability to park calls on to
a call parking device. A parked call can be picked up from any phone on the CallManager by simply
dialing the extension number at which the call is parked. You can either park a call on a specific Park
Device, or let the system select the device for you. You can see the available Call Parking devices in the
Call Park area.

To park a call using a keyboard, perform the following steps:

Procedure

Press F7 key to select Active Calls area.
Select a call using up and down arrow keys.

Press the Home key to park the call on one of the available call parking devices.

To park call using a mouse, perform the following steps:

Procedure

Select a call in the Active Calls field.
Click the &= Park Call button.

To Park a call on a specific device using the mouse, perform the following steps:

Procedure

Select the call in the Active Calls field

Drag the call to the desired Park device and drop the call by releasing the mouse button.

If a parked call is not answered within a certain time duration, the call is reverted back to the Call
Progress Area. Such calls can then be handled through Reverted Call Controls explained in the latter
part of the guide.

Retrieving Parked Calls

Step 1
Step 2

To retrieve a parked call using a mouse, perform the following steps:

Procedure

Select the relevant call parking device.

Click the %% Retrieve button.

To retrieve a parked call using the keyboard, perform the following steps:

[ oL-20131-01
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Procedure

Step 1 Dial the Park device number.

Step2  Alternatively, if a parked call remains unanswered for a certain period of time (known as Call Park
Recall), it will revert back to the Call Progress area, from where the Attendant Console can retrieve the
call using methods stated in Retrieving Held Calls section.

Conference Calls

A Conference call allows you to add a third person to a call session.
With a connected call, to start conference with a third party using a mouse, perform the following steps:

Procedure

Step1  Select the extension that is to be added into the conference or type the number.
Step2  Press the ‘é Start Conference button and the conference is initiated.

g
Step3  Wait for the third party to answer and press the %= Conference button.

With a connected call, to start conference with a third party using the keyboard, perform the following
steps:

Procedure

Step 1 Select the extension that is to be added into the conference or type the number.
Step2  Press the End key on the keyboard
Step3  Wait for the third party to answer and press the End key to join all three parties.

Once the conference is in progress an additional field is highlighted in the Active Calls area. The field
is labeled as Conference Controller and is used to drop you out from the call once all the parties are in
conversation. Figure 3-7 provides an example of a conference call in the Active Calls area.
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Re-establish Calls

Figure 3-7 Displays a Conference Call in the Call Progress Area
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If any of the parties does not respond to the conference call, the call is reverted back. Such calls can then
be handled through Reverted Call Controls explained in the latter part of the guide.

Note  If the third person does not want to start the conference, Cisco Unified Business/Department Attendant
Console clears the initiated call. This will take you back to the original call.

Re-establish Calls

This feature is a time saver. The re-establishing of calls means to repeat the previous process in a single
click. From the F5 and F7 fields you can re-establish the calls to undo the previous action as in the
following areas:

Hold Call
Transfer Call
Conference Call

Park Call

If due to some reason the process does not succeed, you can click the Re-establish button to repeat it.
If you are using a keyboard, press Delete to re-establish.

Toggle Calls

With two active calls in progress, one held and one connected, you can toggle between them.

[ oL-20131-01
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When a contact is called for consultation, the incoming call is put on hold. Once the destination accepts
answers, you can right click on the incoming call in the Active Calls area and choose Toggle. The
incoming call that was held during consultation will become active.

On the other hand, the call made to the external contact will be put on hold. You can also toggle using
the keyboard using the ‘+’ key.

Reverted Call Control

If a call cannot be put through to an extension, it will be returned to the Call Progress Area (F5). This
may be because the contact could not answer the call in time. Cisco Unified Business/Department
Attendant Console provides a set of call controls specifically configured to handle reverted calls without
having to search for the recipient again.

Once the call hits the Active Calls area after being recalled from the Call Progress area, you can view
the Reverted Call Controls by simply right-clicking on the call.

These call controls are similar to the ones explained previously. The only difference is that in case of
reverted calls, all the call controls are in context to the contact the call was initially transferred to.

If you right-click on the retrieved call and choose Start Conference, the contact on the extension from
where the call was reverted will be added to the conference automatically. You would not need to search
through the directory or specify the extension for that particular contact.

Call Controls for Reverted Calls

Table 3-5 gives a brief description of the functionalities that can be performed on a retrieved call.

Table 3-5 Lists the Call Controls Used on Reverted Calls

Control Name Icon Description

Clear Call Click to clear an answered call.

Consult 24 Click to consult and transfer the answered call to the
extension from where the call was initially reverted.

Blind Transfer Click to transfer the answered call to the extension from

where the call was initially reverted.

Re-establish Click to redo an action previously performed on the reverted
call.
Hold with Notes Click to attach notes to the current call before placing the
=

call on hold.

Hold

&

Click to place the reverted call directly on hold for the same
extension/contact the call was reverted from, without taking
notes for the contact.

Contact Properties

L]
i

Click to add or update details of the contact from which the
call was reverted.

Start Conference Click to consult and start conference with the contact the

call was reverted from.

a
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FAC and CMC Settings

Table 3-5 Lists the Call Controls Used on Reverted Calls (continued)
Control Name Icon Description
Camp on (Tt Click to transfer a call to a busy Operator.
(]
Park Call = Click to place the call on a Call Parking Device.
HELS

Right clicking on a call in the Active Calls area and choosing an option from the context menu can also
perform the above-mentioned operations. You can also access these options using your keyboard (Please
refer to Chapter 1 Getting Started 1 <$volnum>“Using the Keyboard”page 1 - 1 section).

FAC and CMC Settings

You may need to provide a Forced Authorization Code (FAC) and/or Client Matter Code (CMC) to
perform an External Blind Transfer. The Administrator configures these codes through Cisco Unified

Attendant Admin. If this is required during a consultation transfer you will see a dialog box on screen,
simply enter the correct code and your call will be made.

Forced Authorization Code (FAC)

Forced Authorization Codes are used to provide security in Cisco Unified CallManager for dialing
Route Patterns. Traditionally, this is used to block calls to external or international numbers. For
example, often in call centers, only some agents are allowed to make external consult transfers to certain
numbers. In order to enforce security, these callers are provided with a Forced Authorization Code. The
concept of FAC is that if you make such an external call transfer that is protected by a FAC, you must
enter the FAC before the call can continue. If an incorrect FAC is entered, or if no FAC is entered, the
call fails. Figure 3-8 displays the FAC Dialogue box.

Figure 3-8 Displays the FAC Dialogue Box

Code Required

Pleaze enter pour Forced Authorization Code.

1234

Client Matter Code (CMC)

Client Matter Codes are used to provide extra call logging facilities within Cisco Unified CallManager.
This is used to log calls for different clients.

The concept of the CMC is that you must enter CMC Code before an external call or transfer can
proceed. The call detail records are updated with the CMC code along with the call information. This
can then be used later on to charge calls to different cost centers.

[ oL-20131-01
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W Clearing Calls

Clearing Calls

In order to disconnect an active call when the enquiry is complete, you need to clear the call from the
Active Calls area.

To clear a call using the keyboard, perform the following steps:

Procedure

Step 1 Press F7 to select the Active Calls field.
Step2  Press Enter.

To clear a call using a mouse, perform the following steps:

Procedure

Step 1 Click on a relevant call within the Active Calls field.
Step2  Right click to open the context menu.
Step3  Choose the Clear Call option.

Using Emergency Mode
N

Note  This functionality is not available in Cisco Unified Department Attendant Console.

Cisco Unified Business/Department Attendant Console allows you to set emergency mode for all the
queues. When the queues are in emergency mode, all calls are automatically redirected to another
destination, Night Service or Voicemail for example. These destinations are configured by the System
Administrator.

To put a queue in Emergency Mode using the keyboard, perform the following steps:

Procedure

Step 1 From the main menu, choose Options > Emergency.

33
Step2  Move the Available Queues to the Emergency Queues list using the —I button to move all Queues,
or the |¥% "} button to select Queues from the list. Figure 3-9 displays the message box that appears,
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Using Emergency Mode W

Figure 3-9 Displays the Message Box that Appears Before Placing the Queues in Emergency
Mode

Set Emergency Mode x|

‘ou are about ko place all the queues into emergency mode.
If wou continue calls will no longer appear in the gueue(s),

Are you sure you wank bo continue?

ko Cancel

Step3  Click Yes to move all the queues to emergency mode.

Stepd  Press OK to complete the process.

You can also use the keyboard shortcut to switch to emergency mode. Select the Queue Area and press
Ctrl"E. The following window is displayed. Click OK to continue.Figure 3-10 displays an example of
the Emergency Mode screen with a Queue placed in Emergency Mode.

Figure 3-10 Displays the Queues that are Placed in Emergency Mode

S

Aevailable Queues:

<4

To take queues out of Emergency Mode, perform the following steps:

Procedure

Step 1 Right click on any selected queue.
Step2  Select Emergency from the context menu.

Step3  Click OK to complete the process.

Cisco Unified Business/Department Attendant Console User Guide
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Sending Email

When you forward a call to an extension and it is returned on time out, you have the option to send an
email to the person to provide important information about the call. The shortcut key for sending email
is Ctrl*M.

Note  There has to be an email address in the Contact Details for the Cisco Unified Business/Department
Attendant Console to be able to function.

Call Status

You can view the call status for any device in the Internal Directory. The Status window allows the
operator to view the status of a contact prior to transferring a call or connecting a contact to a conference
call.

To view device status, perform the following steps:

Procedure

Step 1 In the Internal Directory, right click on a device.

Step2  Choose Status > Calls.

In the Call Status window, you can view the following information.Table 3-6 provides an example of
the contents that would be displayed in the Call Status window, and Figure 3-11 shows how that appears
on the screen.

Table 3-6 Describes the Fields Displayed on the Call Status Window

Field Example Description

Name John Smith Name of the contact

CLI 2000 This is the number call was made from
DDI 1001 This is the number call was made to
Status Talking The current status of the call

You can also answer any ringing call by clicking the Answer button.
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Figure 3-11 Displays the Call Status Window for the Selected Contact
John Smith [1001] I 2 x|
— Callz
Name | cu | Dol | Status |
S ek Smith 2000 1001 Talking
il
i ]
ok Help

Contact Properties

Each directory contact will have relevant pieces of information attached to it. Some information will be
displayed in the Internal and External directories. To see more information for a specific contact a
Contact Details form can be displayed by pressing the F12 key on the keyboard.

When a contact is opened information already attached to the contact is displayed, and certain fields will
be greyed out. This information cannot be changed. All other fields are available for editing as required.
You can change the details and click on the OK button to save the changes. Please note the fields that
you can edit are the ones that are not mapped through LDAP synchronization.

Email Contact

If the email address of the contact person is added in the Contact Details, then Attendant Console can
mail the contact from this window. It will open the mail client configured on your machine. You can click
the % to write an email. Figure 3-12 displays the Contact Details window.

Cisco Unified Business/Department Attendant Console User Guide
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M Contact Properties

Figure 3-12 Displays the Contact Details Window for the Selected Contact

| Cantact Numhersl En:nmpan_l,ll Mates I

— Contact Details
Title: |

Iriikialz: I

First M arme; IJu:uhn
Middle Hame: |

[Lagt fame: ISmith

Erriail | =

Use Number

In the Contact Numbers tab of the Contact Details window, you can select an external phone number
of the contact person, and click the Use Number button to automatically dial a number.

Figure 3-13 Displays the Call Status Window for the selected contact

Details | Cortact NUITIbEfSEl En:nmpan_l,ll Motes I

— Contact Humbers
air Exterisior  [BE1S [ BLF

Buzsiness 1: IEEEEI'I 11

Business 2 I
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i bl

Fager

Faw

ze Murmter |

To edit contact properties using the mouse, perform the following steps:

Procedure,

Step1  Select a contact from the Internal/External Directory.
Step2  Right click on the contact to view the context menu.
Step3  Choose Properties.

Step4  Give the details in the Contact Details window.

Step5 Click OK.

To edit contact properties using the keyboard, perform the following steps:
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Adding Absent Message and Contact Information [l

Procedure

Step 1 Press F3 or F4 to select a directory.

Step2  Use up and down arrow keys to select a contact.
Step3  Press F12 to open the Contact Properties window.
Step4  Enter the details for the contact.

Step5 Click OK.

Adding Absent Message and Contact Information

It is also possible to add Absent Messages and General Contact Information through the Notes tab.

¢ Contact Information - Add extra information to any of the contacts in the directories. This
information will be displayed with the contact as tool tip.

e Absent Message - Add an absent message with any of the devices in Internal Directory field.

)

Note  This information is displayed with the contact as tool tip.

Cisco Unified Presence Status

Cisco Unified Business/Department Attendant Console can view CUP (Cisco Unified Presence)
Information for all contacts. IP Phone users can now set a status for themselves that is reflected onto
Attendant Console Internal Directory. This allows you to manage calls efficiently since it can be easily
found out whether a particular contact is available or not. Figure 3-14 shows an example of CUPs
Presence information displayed in the Internal directory area.

Cisco Unified Business/Department Attendant Console User Guide
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W Cisco Unified Presence Status

Figure 3-14 Displays CUP Presence Information
[F3] - Internal Directory BIE]E
Last Mame Firs
B = | o | Number | Last Ma
" & 0o K.aren
2 :‘% 1000 Cal
= - ;
. 2 100 Sriith
i 1004 Foster
= = 2000 Junior

Where a contact status has been set, the following presence status icons will be displayed in the Internal
Directory [F3] and External Directory [F4] windows. The different icons are reflected in the Table 3-7.

Table 3-7 CUP Presence Status Icons.
Icon Status Description
@ Away Presence status away\be right back.
- Busy Presence status busy.
@ DND Presence status Do Not Disturb (DND).
Offline Presence status offline.
Iél' Online Presence status online (available).
? Unknown Presence status unknown.

To view Presence Status, perform the following steps:

Procedure

Step1  Select a contact in Internal Directory.
Step2  Hover over a presence status graphic.

Step3  Presence Status details will be displayed

There is also facility to hover over the contact icon with the mouse and a pop up display will provide any
additional information that might be available for the status (ie in the case of Vacation it will display a
return date).
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Glossary

Revised: October 9th, 2009

Absent Message A little note about the extension when it is not to
be disturbed or absent.

Busy Lamp Field Set of Internal Extensions assigned to the
Operator. Operator can monitor their status
through Cisco Unified Business/Department
Attendant Console.

Call Origin Whether the call is an internal or external call.
(INT or EXT).

Call Parking Devices Virtual devices where calls can be held
temporarily and picked from any other call centre
extension.

CLI Number It is defined as Caller Line Identification The
caller's number.

Call Status It tells what is currently happening to the call. It
can be Ringing, Held, Connected or Busy.

Call Type It tells whether the call is an inbound, outbound or
a transferred call. (IN/OUT/TFR).

Directory Group Set of Internal extensions grouped together to be
assigned to any Operator afterwards in
Configuration.

Extension Physical phone in call centre.

External Directory External Directory is the list of External numbers
for internal contacts.

Field Headers Titles of different sections in Attendant Console.

Internal Directory Internal Directory is the Internal Extensions of

Call Centre. These are the devices added in Main
Directory section in Configuration.

Call Queuing The ability for a physical phone to have several
calls stacked on the line waiting to be answered.
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Toggle Changing a call state from help to active or vice
versa.

Reverted Call A call that hits the Call Progress area if it is left
unanswered by a contact.
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